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I. Introduction
I-1. Purpose
This document provides specific technical information for users of the CLEA software module Astrometry of Asteroids.
It includes discussions of hardware and operating system requirements (Section II); software installation and operation
(Section III); files associated with the exercise (Section IV); user options and file formats for possible user modifications
(Section V); and astronomical data, models, and algorithms employed in the software (Section VI). The material in this
guide is intended for use by the instructor and by other personnel involved in installing and configuring the exercise
software and PC hardware. It is not intended for distribution to the students. (The word “user” when it appears herein
should be interpreted as “instructor”, and not “student”.)
Readers of this document are assumed to have available the General Users’ Guide to CLEA Software, which contains
technical information that applies to all CLEA Windows software. Significant information contained therein is not
repeated here. In cases of conflicting information, this guide should be considered definitive for the Astrometry of
Asteroids software. In particular, please note that the software is distributed in a different form than most previous
CLEA modules (see Section III for details), and the system requirements (Section II) are somewhat more stringent.
I-2. Acknowledgments
Development of CLEA exercises and materials, including this guide, is supported in part by National Science Foundation
Grants USE 9155927, USE 9354514 and DUE 9652801, and by Gettysburg College.
I-3. The Astrometry Toolkit
Unlike other CLEA software modules, which provide simulations of astronomical observations and activities, the
software supplied for the Astrometry of Asteroids exercise actually performs the operation it illustrates, the astrometric
measurement of CCD images. The rapidly increasing availability and popularity of CCD equipment among amateur
astronomers and at smaller professional installations, combined with the universal availability of high-performance
computers, has vastly increased the number of individuals/sites capable of doing accurate and meaningful astrometry of
asteroids and comets. While there are software packages currently available for this work, we at Project CLEA feel our
software provides some distinct advantages, and we are making it available in an enhanced “professional” version which
we call The CLEA Toolkit for CCD Astrometry. Because the Astrometry Toolkit software is designed and implemented
specifically for Windows 95/98/NT, it is freed from the restrictions and limitations of DOS software, allowing it greater
flexibility/versatility; and features a user interface structure that is, by now, familiar to most computer users.
Some enhancements to the exercise software available in the Toolkit include:
1.

Formal reports of results are generated in the 80-column format required for submission to the Minor Planet
Center (see Section VI-5).

2.

Report data may be saved between sessions, then reloaded for the inclusion of additional measurements.
Individual entries may be edited or deleted.

3.

Reference files of camera data and observing sites may be created for fast access.

4.

As a aid to observers, the software includes an ephemeris generation facility. This feature can:

•

Access the Asteroid Orbital Elements Database (Section V-2.3), which provides high-precision
osculating elements for all numbered asteroids and most of the unnumbered ones, or use elements
supplied by the user.
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•

Generate and print positional ephemerides at any desired time interval.

•

Utilize the star catalogs to generate and print finding charts, in either white-on-black or black-onwhite format. Field size and limiting magnitude are set by the user. Measured positions of target
objects can also be charted and printed.

The CLEA Toolkit for CCD Astrometry is available through a licensing agreement with Project CLEA. If you are
interested, contact us by E-mail (clea@gettysburg.edu), or at the address/telephone number shown on the cover. You
should also be aware that in order to make full use of the Toolkit, you will need copies of the Guide Star Catalog (CDROM), the USNO-SA1.0 supplementary catalog (CD-ROM), and the Asteroid Orbital Elements Database (available via
download). These are described in Section V-2 of this document.
NOTE: In order to avoid having to create and maintain separate document versions, some material which
appears in this guide applies only to the Toolkit, and not the exercise software. In general these items are noted
as such. If we have missed any, we apologize for the confusion.

II. System Requirements
This software runs under Microsoft Windows 95/98/NT. As a 32-bit Windows application, it will not run under Windows
3.1/3.11 (see NOTE below). A minimum of 16 Mbytes of RAM is recommended, although smaller configurations (down
to 8 MB for Win95) may prove sufficient. A color SVGA video controller and monitor are required, and must be
operating at a screen resolution of 800 by 600 pixels or better. (The software will NOT run if the screen resolution is 640
by 480 pixels.) The color palette must include at least 256 colors, a higher color mode (16, 24 or 32-bit) is recommended. A full installation (not including supplementary material described in Section V-2) will require about 15 Mbytes
of hard disk storage.
NOTE: We have chosen to distribute this software initially only in a 32-bit executable version, as stated above.
Although it is possible for us to produce a 16-bit version for use under Windows 3.1/3.11, to do so will require a
fair amount of effort on our part, which will impact the development of future exercises. At the present time, we
do not have a good indication of the demand for continuing production of 16-bit software. If you are still
running Windows 3.1/3.11 and must have 16-bit software, please let us know (clea@gettysburg.edu). If the
demand is sufficient, we will develop and distribute a 16-bit version. On the other hand, if demand appears to
be small (and presumably shrinking), we will be justified in eliminating the requirement for 16-bit versions from
our development plans.
Users may find that PCs employing 386 processors, while usable, are not fully adequate for this software; annoying (and
in some cases) considerable delays may be experienced at certain points. 486 processors are generally satisfactory, if the
memory and video requirements stated above are met. No problems (that we are aware of) have been experienced with
Pentium processors.

III. Installation and Operation
This software is distributed as a self-extracting executable installation module. Due to the number and size of the
included data files (particularly the images), the installation file is significantly larger than for other CLEA exercises.
Since this would require a number of floppy disks, and since virtually all commercial software is now distributed primarily on CD-ROM, we have chosen that as our primary medium for distribution to users who prefer not to download. As is
the case for all CLEA Windows software, this exercise may be downloaded via our Website (begin with the Project
CLEA homepage at www.gettysburg.edu/project/physics/clea/CLEAhome.html), or directly from the CLEA ftp site
(io.cc.gettysburg.edu). If you must have floppies, we can accommodate you by special request. Contact us by E-mail at
clea@gettysburg.edu.
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III-1. Installation on a Single Computer
Before beginning any installation procedure under Windows, it is advisable to terminate all active programs. This
includes all programs appearing on the task bar, and items such as the Microsoft Office Toolbar. Then follow one of the
procedures below.
To install the exercise from a CD-ROM:
1.

Place the distribution CD-ROM in the drive.

2.

Using Windows Explorer, access the CD-ROM drive. (This will be drive D: or higher, depending on the
number of hard disks drives/partitions on your machine.)

3.

Double-click on the entry for IN95_AST.EXE in the Windows Explorer display.

To install the exercise from a downloaded module:
1.

Using Windows Explorer, locate the module IN95_AST.EXE. (You will have placed this module in some
folder, such as C:\SAVSTUFF\CLEA, when you downloaded it. If you are unsure of the folder, you can select
Tools…Find…Files or Folders... from the Windows Explorer menu to help you locate IN95_AST.EXE.)

2.

Double-click on the program entry for IN95_AST.EXE in the display.

NOTE: Experienced Windows users will realize that there are means other than those described above to initiate
the install program. A quick method, if you are certain of the path and file names, is to select Start…Run.... In
the dialog box, enter the path and program name (such as “D:\IN95_AST.EXE” or
“C:\SAVSTUFF\CLEA\IN95_AST.EXE”), and click on OK. Use whatever method you prefer.
After the installation program starts it will ask you to select a folder in which to place the software, and a program group
for the icon. (If you have already created a program group for other CLEA software you will probably want to place this
exercise there also.) Except for these selections, the installation process is completely automatic and quite fast. When it
is finished, an icon for the exercise should appear in the selected program group and on the Start menu.
III-2. Network Installation
Installation of CLEA software on networks is described in detail in the General Users’ Guide to CLEA Windows
Software. Because this exercise is not distributed as a .ZIP file, you must run the installation program as described
above to unpack the files. For a network installation, identify the appropriate shared drive when specifying the folder to
hold the software. (Obviously, you must have write privileges on the network drive when you do this.) Another technique is to install the software on any PC, and then copy the entire contents of the program folder to the network drive. If
you use this method, be sure that you copy and leave intact all sub-folders that have been created by the install program.
These folders contain data from the Guide Star Catalog (see Section V-2.1). Once you have copied all the folders to the
network drive, you must create a local directory and install the exercise on all machines that will use it. This process is
described in Section III of the General Users’ Guide to CLEA Windows Software.

IV. Files Included With This Exercise
IV-1. Files Created During Installation
The following files are compressed into the distribution file IN95_AST.EXE. The compressed files are extracted and
placed in the exercise folder during installation. The list is grouped by function, with references to related discussions in
this document and the General Users’ Guide to CLEA Windows Software where appropriate.
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Software and Documentation
README.AST

Notes on the current version, if any.

UPDATE.AST

A list of updates (by version) since version 0.70 (the first version to be widely
circulated).

ASTGUIDE.PDF

This document, in PDF format. Use Adobe Acrobat to read, print.

CL32_AST.EXE

32-bit executable code for the exercise.

Bitmap Files for Displays
CLEALOGO.BMP

Bitmap data (256-color) for the CLEA logo screen.

ASTRMEX.BMP

Bitmap data (256-color) for the Exercise title screen.

ASTROMET.BMP

Bitmap data (256-color) for the Astrometric Toolkit title screen (see Section I-3).

CLEADKBL.ICO

Icon for the Astrometry of Asteroids exercise.

Image and Data Files for Exercises (Section V-2)
92JB05.FTS
92JB07.FTS
92JB08.FTS
92JB09.FTS
92JB10.FTS
92JB12.FTS
92JB14.FTS

Sequential images of asteroid 1992JB, taken May 23, 1992

ASTWEST.FTS
ASTEAST.FTS

Parallax images of asteroid 1992JB, taken 06:57:00 UT May 23, 1992

ELE02F~1.FTS
ELE03F~1.FTS

Images of asteroid (354) Eleonora, taken February 04, 1996. These images are
supplied as additional data. They are not utilized explicitly in the exercise.

The following files are excerpted from The Guide Star Catalog, Version 1.1 (see Section V-2.1) to provide reference
stars for measurement of the fields listed above. They must be placed in the folders indicated, under the folder where the
software is located. (This is done automatically by the installation program.)
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TABLES\REGIONS.TBL

The (entire) GSC Regions Table.

GSC\N0730\0932.GSC
GSC\N0730\0936.GSC
GSC\N1500\1391.GSC
GSC\N1500\1398.GSC

GSC Data Files.
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User Data Reference Files (Section IV-2.2)
ASTSITES.DAT

Reference file of observing sites.

ASTCAMS.DAT

Reference file of CCD camera data (Astrometry Toolkit only - see Section I-3).

Help and Related Files (Section V-3 in General Users’ Guide to CLEA Windows Software)
CLEAHELP.HLP

Text for Help->On Help.

ASTRMHLP.LST

Topic Index List for Help on exercise software.

ASTRMLAB.HLP

Text for Help topics on exercise software.

TOOLSHLP.LST

Topic Index List for Help on Astrometry Toolkit features (see Section I-3).

TOOLKIT.HLP

Text for Help topics on Astrometry Toolkit features (see Section I-3).

REMINDER.AST

Text to display when Exit is selected.

IV-2. Files Generated During Execution
IV-2.1. Housekeeping Files
The following files, which contain housekeeping information, are automatically created during execution of this exercise.
CLEALOG.LOG

A record that includes the program name (CLEA_AST), the date and time, and the
names and table number from the Login dialog is appended to this file whenever the
exercise is started, and when it is terminated. This file is in text format and can be
read and/or printed at any time. Since this file can grow without limit it should be
deleted from time to time (via DOS or the Windows Explorer), a new file will then be
started at the next login. This file can optionally be given a different name (see
Section V-1.2).

NOTE: A logout record will be written to this file only if the students exit correctly from the
program (select File…Exit from the main menu, or close the main window from the System
Menu or “X” box). They should be instructed to do this, rather than simply abandoning the
computer or turning it off.
ASTROPTS.INI

Current settings for file names and options. This file can be deleted if desired, it will
then be re-created from internal defaults when the program is run. If the options are
updated (see Section V-1), the previous version is saved as ASTROPTS.BAK.

IV-2.2. User Data Reference Files
The following files comprise a user-generated database of information used in computations and reports. Since these
files are in binary format, you cannot read or modify them with a text editor. You may access, add, and delete records
from within the astrometry program. You may change the file names if you wish (see Section V-1).
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IV-2.2.1. Site Data Reference File
This file contains records holding observing site data, including observatory name and code; latitude, longitude, altitude
and time zone; and telescope description. This information appears on the formal results report (Astrometry Toolkit - see
Section I-3), and is used in the computation of projected baselines between observatories. A small default version of this
file (named ASTSITES.DAT) is provided at installation.
IV-2.2.2. Camera Data Reference File
This file contains records holding CCD camera data, including camera name or ID, pixel dimensions, filter, and other
data. This information appears on the formal results report, and is used to calculate field dimensions and scale, and
telescope focal length (Astrometry Toolkit only - see Section I-3). A small default version of this file (named
ASTCAMS.DAT) is provided at installation. It contains information on the Santa Barbara Instrument Group (SBIG)
cameras.
IV-2.3. Report Data
All reports generated by this software can be printed and/or saved as text files (default extension .TXT). This includes
reports of results, astrometric solutions, image file header material, image statistics and display parameters. In the
Astrometry Toolkit (see Section I-3), generated ephemerides can also be saved as text files, and formal report data can be
saved in binary format (default extension .RPT) for later use. Most of these reports can also be saved in the Comma
Separated Values (extension .CSV) text format for input to spreadsheet programs.

V. User Options and Data
V-1. Parameters and Selectable Options
In all CLEA software, modification of control parameters and options is accomplished through an options dialog that is
accessed from the login dialog, via a password. Details of this feature, including the password access, are provided in the
General Users’ Guide to CLEA Windows Software. Due to the number of modifiable features associated with this
exercise, the options facility comprises several dialog windows, as detailed in the Sections that follow (V-1.1 through V1.3).
V-1.1. Software Options and Parameters
The following switches and parameters appear on the window titled Software Options, which appears as the main dialog
when the facility is accessed.
Software Use: Select whether software is to be used as a CLEA exercise or for CCD astrometry. This switch is
available only on the Astrometry Toolkit version of the software (see Section I-3).
Guide Star Catalog: Set this flag to indicate that the full GSC is to be used (see Section V-2 and Guide Star
Catalog Path parameters in Section V-1.2). Note that this flag is set automatically in CCD Astrometry
(Toolkit) mode, in Exercise mode the default is Off.
USNO-SA1.0: Set this flag to indicate that the USNO-SA1.0 supplementary catalog is to be used (see Section
V-2 and USNO-SA1.0 Path parameter in Section V-1.2). The default is Off.
Demonstration Mode: This option is provided for those who may wish to avoid the login process when using
this software as a demonstration. When this switch is on, the Run selection as well as Login (both
under File on the main menu), are enabled when the program starts.
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If Run is then selected before Login, the program proceeds as if the login process had actually occurred. (In this case the 1st login name is set to Demonstration, the file name base becomes DEMO,
and the Login menu selection is disabled.) This flag is set automatically in CCD Astrometry (Toolkit)
mode, in Exercise mode the default is Off. (Also see Test Mode.)
Test Mode: In test mode, the Preferences menu selection for user options is always enabled. Instructors may
find this mode useful for demonstrations and in setting up exercises. This flag is set automatically in
CCD Astrometry (Toolkit) mode, in Exercise mode the default is Off. (Also see Demonstration
Mode.)
File Format: This switch sets the default image file type. Note that the ST-4 type is separated from the other
SBIG types (ST-4, ST-5, ST-6, ST-7, ST-8), primarily because of the difference in header information.
The file format can be changed from the File menu (File->Image File Type) during execution. The
default file format is FITS.
File Header Time: The switch sets the default interpretation of the observation time (UT) parameter given in
the file header. Like the file format, this parameter can be changed from the File menu (File->Image
File Type) during execution. For FITS files, the default is “Midpoint of Exposure”. For SBIG files,
the default is “Start of Exposure”. (ST-4 files do not carry a time parameter, so this switch has no
meaning.)
Lab Table Number: This field allows the instructor to preset the table number for each machine in the lab.
This number then appears as the default on the Login dialog. The table number has a maximum length
of 4 characters, but need not be numeric.
Password: This is the password for access to the Options dialog. Allowable passwords have a maximum length
of 16 characters, and are case sensitive. The default password is “CLEA”, a special password is
required for the Astrometry Toolkit (Section I-3).

V-1.2. File Name Options
The following file and path name parameters appear on the window titled File Name Options. To access this dialog
press the button labeled Files... on the Software Options dialog. See the General Users’ Guide to CLEA Windows
Software for discussions of Windows bitmap (.BMP) files, including logo and title screens and color issues.
Bitmap Files
Logo: A 256-color bitmap for the CLEA logo screen. The default is “CLEALOGO.BMP”.
Exercise Title: A 256-color bitmap for the exercise title screen. The default is “ASTRMEX.BMP”.
Astrometry Title: A 256-color bitmap for the Astrometry Toolkit (Section I-3) title screen the default is
“ASTROMET.BMP”.
Help Files
Exercise Help List: An index list of Help topics (see General Users’ Guide to CLEA Windows Software)
for the exercise software. The default is “ASTRMHLP.LST”.
Toolkit Help List: An index list of Help topics for the Astrometry Toolkit (see Section I-3) software. The
default is “TOOLSHLP.LST”.
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User Help File: Site-specific Help information available under Help…User (see General Users’ Guide to
CLEA Windows Software). The default is “” (no entry).
Reminder File: Text to be displayed when the students want to terminate the exercise (see General Users’
Guide to CLEA Windows Software). The default is “REMINDER.AST”.
System Files
Spreadsheet Program File: The full name (including path) of a spreadsheet program to be accessed during the
exercise for data manipulation and analysis. The file must be of type .EXE or .PIF, and must be
accessible from the student’s computer in the drive and file specified (example:
C:\MSOFFICE\EXCEL\EXCEL.EXE). This parameter is completely optional. There is no default.
Log File: A file (text) where log information is written during login and at termination of the exercise (see
Section IV-2). This file name can optionally include a full path, presumably to a single shared log file
(which of course must be write-enabled). The default is “CLEALOG.LOG”, with no path designation.
Data Files (see Section V-2)
Guide Star Catalog Volume 1 Path: The path to Volume 1 of the GSC. This may be a CD-ROM drive letter,
or a folder on a local or shared hard drive. Do not include a file name.
Guide Star Catalog Volume 2 Path: The path to Volume 2 of the GSC. This may be a CD-ROM drive letter,
or a folder on a local or shared hard drive. Do not include a file name.
USNO-SA1.0 Path: The path to the USNO-SA1.0 supplementary catalog. This may be a CD-ROM drive letter,
or a folder on a local or shared hard drive. Do not include a file name.
Asteroid Orbit File Path: The path to the Asteroid Orbital Elements Database (Section V-2.3). Do not
include a filename. (The filename will default to “ASTORB.DAT”.)
Stations File: The name (may include path) of the Site Data Reference File (Section IV-2.2.1).
Camera File: The name (may include path) of the Camera Data Reference File (Section IV-2.2.2).

V-1.3. Other Options and Parameters
Two additional option dialog windows, User Parameters and Camera Parameters, are provided to users of the
Astrometry Toolkit (see Section I-3). A third, Site Parameters, is provided to both exercise and Toolkit users. These
dialogs are accessible through the main options window, and individually under File… Preferences... from the main
menu. Most of the requested parameters and data items on these dialogs are self-explanatory, pop-up “hints” will appear
to supply units and other information where needed. The Camera Parameters and Site Parameters dialogs include
facilities to create and access User Data Reference Files (see Section IV-2.2).
The User Parameters provide contact information on the formal results report. The Camera Parameters also appear
on the formal report, and are used in the computation of field scale and size, and effective focal length. The Site Parameters appear on the formal report, and are used in the computation of baselines for asteroid parallax.
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V-2. Supplemental Data Files
The following files provide the astrometric catalog and orbital parameter data used by the software. Of these, only a
small subset of the GSC, sufficient to perform the exercise as given in the Student Manual, is included in the installation
file (see Section IV-1). Users wishing to modify or extend the exercise material, and all Toolkit users, will need to obtain
at least the full GSC to provide full sky coverage. Project CLEA does not supply these files; they must be obtained from
the sources indicated.
In order to use any of these files, you must:

•

For the star catalogs, set the appropriate software option flag(s) (Section V-1.1).

•

Provide the path information in the file name options (Section V-1.2, also see V-2.4 below).

V-2.1. The Guide Star Catalog
The Hubble Space Telescope Guide Star Catalog provides astrometric positions of more than 15 million stars brighter
than sixteenth magnitude. Coverage of the entire sky is provided on two CD-ROMs, divided at a declination of -7.5 deg.
Information regarding file structure and formats, astrometric and photometric accuracies, and references to published
papers is provided with the CD-ROMs. The Guide Star Catalog Version 1.1 is available for about $70 from:
The Astronomical Society of the Pacific
390 Ashton Avenue
San Francisco, CA 94112 USA
Ph. 1-800-335-2624

V-2.2. The USNO-SA1.0 Supplementary Catalog
The USNO-SA1.0 is a catalog of 54,787,624 sources intended to provide a grid of astrometric reference objects over the
whole sky. The bulk of the objects have magnitudes (blue) between 12 and 19. Red magnitudes are also given. The
USNO-SA1.0 is distributed on a CD-ROM free of charge. For ordering information and further details about the catalog,
see the website at http://psyche.usno.navy.mil/pmm/.
The selection criteria used to create the USNO-SA1.0 means that many objects visible on a CCD image of a given field
may not be in the catalog, which can make field identification confusing and difficult. For this reason, you cannot use the
USNO-SA1.0 by itself with this software (exercise or Toolkit), but only as a supplement to the GSC (Section V-2.1). Of
course, once the reference field has been generated, you can, if you wish, select only SA1.0 stars, or only GSC stars, or
any combination of both, to be used as references in the astrometric and/or photometric solution.
V-2.3. The Asteroid Orbital Elements Database
The Asteroid Orbital Elements Database is an ASCII file of high-precision osculating orbital elements, ephemeris
uncertainties, and some additional data for all the numbered asteroids and the vast majority of unnumbered asteroids for
which it is possible to make reasonably determinate computations. Some special features of this file, which make it an
extremely valuable resource, include:
1.

The database is updated daily. Observations in each new batch of Minor Planet Circulars are used in new
orbits on a monthly basis, those in the Minor Planet Electronic Circulars are used shortly after they are published.
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2.

All the orbits in a given version of the file have an epoch of osculation near the present. Ephemerides of most
non-Earth-approaching asteroids can be computed to arcsecond or better accuracy within about 50 days of the
epoch using a 2-body ephemeris program (see Section VI-4).

3.

Current and future ephemeris uncertainties are given, allowing observers to readily estimate whether asteroids
are likely to be within their telescope’s field of view, and enabling them to prioritize astrometric targets.

The Asteroid Orbital Elements Database is available free of charge via ftp download. You can access it, and get more
information about it, via the web at ftp://ftp.lowell.edu/pub/elgb/astorb.html. The total decompressed size of the file is
(currently) 10.3 Mb. Because of the time-critical nature of this material, serious users should download the latest version
on a fairly frequent basis.
You can use the Asteroid Orbital Elements Database only with the Astrometry Toolkit (Section I-3), which includes
facilities for finding asteroids by number, and by full or partial name/designation.
V-2.4. Location of the Supplemental Files
If you employ both the Guide Star Catalog and the USNO-SA1.0 on a typical system with a single CD-ROM drive, you
will find yourself (or your students) spending a fair amount of time switching the three CD-ROM disks that comprise the
catalog files. For serious users willing to invest in additional hardware, there are at least two possible solutions to this:

•

Multiple disk CD-ROM drives are available. These units identify each disk with a separate drive letter.

•

Very high capacity hard drives are now available at quite reasonable prices. It has therefore become
possible to put some or all of these CDs on hard disk. This will result in very rapid access, and can also be
used on a network to provide all students access to the catalogs without requiring multiple copies. To copy
a CD-ROM to hard disk:
1.

Be sure that you have enough hard drive space. Each CD-ROM can hold approximately 650 Mb
of data; you will also want to leave some free space on the drive. It is a good idea to run the disk
defragmenter on your hard disk before copying CD-ROMs (select
Start…Programs…Accessories…System Tools…Disk Defragmenter). You should run a full
defragmentation that consolidates free space as well as files.

2.

Using the Windows Explorer, create a top-level folder for each CD you will copy (select
File…New…Folder). Volume 1 and Volume 2 of the GSC should be placed in separate folders.

3.

Place the CD in the drive. When it has finished loading, return to the Windows Explorer and click
and drag the icon for the CD-ROM drive to the appropriate folder you have created. This should
result in a full copy that will leave the directory structure intact. Do this for each CD you are copying.

4.

Enter the path to each of the folders you created in the appropriate option parameter entries (see
Section V-1.2).

V-2.5. Image Files for Optional “Unknowns”
Ten pairs of image files (A1.FTS, A2.FTS, …, J1.FTS, J1.FTS) are provided on the installation disk for use with an
optional part of the exercise described in the Student Guide. As the amount of disk space required for these files is
fairly significant (19MByte), their installation is optional. To install these files:
1.
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Create a folder to hold these files. (You may want to name this folder “UNKNOWNS” and place it under
the folder where you have install the software.
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2.

Copy the file UNKNWNS.EXE to the folder you have just created. (This file is located on the distribution
CD_ROM. If you obtained IN95_AST.EXE via download, you will also have to download
UNKNWNS.EXE.)

3.

Locate UNKNWNS.EXE with the Windows Explorer and double-click on it.

4.

To save space, you can delete UNKNWNS.EXE after it has unpacked.

VI. Astronomical Data, Models and Algorithms
The general methods employed by the software in performing its major operations are briefly described in this section.
For more detail, you should consult the references cited. It is the intent of Project CLEA to produce a manual on CCD
astrometry to accompany the Astrometry Toolkit. In the meantime, if you are interested in using the Toolkit to reduce
astrometric measurements for submission to the Minor Planet Center, you should study the material identified in Section
VI-5.
VI-1. Generating Bitmaps for Display
Astronomical CCD image data cannot be displayed directly on a computer screen without manipulation. Under Windows, the most efficient means is to generate a Windows bitmap. Factors that must be considered in this conversion
include:

•

CCD image pixel counts can cover a tremendous range of values, depending on the size of the storage units.
For example; 16-bit data can carry values from 0 to 65,535, while 32-bit data could carry a maximum value
of more than 2.0E+09. Whatever the range, it must be mapped into display pixels that allow values of 0 to
255.

•

For star images, the significant range of values may only be a few hundred counts, while occasional “hot
pixels” may carry the maximum count, or close to it.

•

The background level may be very high, compared to the actual image range.

The result of this is that simply compressing the image counts into 0-255 will almost always yield either a totally white
display or a totally black one, depending on the background level. No star images will be visible.
In some cases, images will have been pre-processed for optimum display before being measured. In the case of SBIG
files (except ST-4) the background and range values the last time the image was stored are saved in the header. FITS
files, however, do not carry this information, and in general the display software must employ some technique to produce
a usable image. The process used (developed empirically) is as follows:

•

The raw image counts are analyzed statistically in a “pre-processing” step to determine the mean and
standard deviation.

•

The image range is set from 0.25 SD below the mean to 1.75 SD above the mean.

•

The image range is compressed into the values 64 to 127 (to allow for adjustments) and the bitmap is
created. A palette is created mapping the image range to the range 0-255.

•

Contrast and brightness adjustments are accomplished by altering the palette mapping.

In the case of SBIG files which carry image range information, the user may chose between using that or the statistically
derived quantities when the file is loaded and the bitmap created.
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With a little user adjustment of brightness and contrast this technique has been found quite effective in rendering visible
star and asteroid images for measurement. It does not always produce the best images of extended sources, although they
too can be adjusted effectively.
VI-2. Image Centroiding
The most critical aspect of an astrometry program is image centroiding. That is, measuring the position of the center of
each star and target object image. In the past, accurately measuring images on photographic plates was tedious work,
requiring much skill and experience.
Today, photographic plates are measured by machines which, although accurate, are cumbersome, slow and expensive.
CCD images, however, lend themselves readily to measurement techniques that are fast, accurate, and can be implemented on small computers. This has greatly increased the number of sites capable of producing timely and accurate
astrometric data of asteroids and comets from a handful of professional observatories to a large number of professional,
amateur, and academic facilities.
Our goal, in developing our astrometry software, has been to implement a centroiding technique that produces accurate,
repeatable results with as little dependence as possible on operator skill or patience. Cursor positioning should be used
only to identify the object, it should (ideally) have no effect on the measured position.
We have implemented the following multi-step process, which tests have shown to closely approach this ideal:
1.

All centroiding calculations are performed using the raw image data, not the generated bitmap. The image
range described in Section VI-1 is used.

2.

In the first step, a circular region (radius 8 pixels) around the cursor position is searched for the pixel with the
highest count. This is used as the center for the next step.

3.

Weighted pixel averages of a circular region (radius again 8 pixels) centered on the high pixel are taken in both
X and Y. The weighting is as follows:

•

Counts lower than the low image cutoff are given weight 0.

•

Counts higher than the high image cutoff are given weight 1000.

•

Counts within the image range are proportionally assigned a weight between 0 and 1000.

•

The weights are cubed and applied to the pixel addresses (X and Y).

•

X and Y averages are taken.

We have found this technique to yield highly repeatable results, and generally to be quite insensitive to cursor positioning.
In cases where the target asteroid is near another image, just a little care in positioning the cursor usually yields the
desired centroid. (If possible, stars with nearby companions should not be used as references in astrometric or photometric solutions.)
VI-3. Astrometric Solutions
An astrometric solution is a mapping of measured (x,y) coordinates on the flat image (in this case, in pixels) to right
ascension and declination on the (curved) celestial sphere. Discussions of this problem are given in Green (Ch. 13) and
Montenbruck and Pfleger (Ch. 12). In outline, the technique is as follows:

•
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Standard Coordinates (X,Y) are defined to lie along the right ascension (East-West) and declination
(North-South) axes, measured from the center of the field. The measurement unit is the telescope focal
length (which need not be known).
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•

Mathematically, these Standard Coordinates may be expressed in terms of celestial coordinates (right
ascension and declination), and the celestial coordinates (α, δ) and the celestrial coordinates of the field
center (A,D) as follows:

cos( δ)sin( α− A )
cos( D ) cos( δ) cos( α− A ) + sin( D ) sin( δ)
sin( D ) cos( δ )cos( α− A ) − cos( D )sin( δ)
Y =−
cos( D ) cos( δ)cos( α− A ) + sin( D ) sin( δ)
X=−



−X
α = A + arctan 

 cos (D) − Y sin (D) 
 sin (D) + Y cos(D) 
δ = arcsin 

2
2


1+ X + Y
•

The following relationships between the Standard Coordinates (X,Y) and measured coordinates on the
image (x,y) are assumed:
X = ax + by +c
Y = dx + ey + f
This formulation automatically accounts for the following instrumental errors, all of which can be shown to
be linear in nature:
1.

Displacement of origin: there are constant differences between the measured and the true coordinates.

2.

Error of orientation: the measurement coordinate system may be rotated with respect to the true
coordinate system.

3.

Non-perpendicularity of axes: the measurement axes may not be strictly orthogonal.

4.

Scale Errors: Strictly speaking, the measured coordinates are expressed in units of the telescope
focal length. Since we use pixels, an automatic scale error is introduced. There may be differing
scale errors in x and y.

The coefficients a,b,c,d,e,f are referred to as the Plate Constants (a relic of pre-CCD astronomy). The
astrometric problem is the determination of the plate constants, and their application to the measured
position of the target.

•

The plate constants are found by measuring the positions of reference stars. The standard coordinates of
these stars are computed from their known celestial coordinates, thus each reference star yields one pair of
equations of the form shown above. Since we must solve for 6 plate constants, we require a minimum of 3
reference stars.
In order to improve the accuracy of the solution, and to provide information on the magnitude of residuals, a
larger number of reference stars is usually employed, and the plate constants are determined by a leastsquares solution.
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•

Once the plate constants are determined, the celestial coordinates of the target can be computed from its
measured position. The solution also yields the telescope effective focal length and the plate scale, and the
true coordinates of the field center.

To perform the required calculations, the CLEA astrometric software uses an adaptation of routines given in
Montenbruck and Pfleger. One point needs to be noted:
One type of instrumental error is not accounted for in the formulation given. Field tilt (non-perpendicularity of
the CCD plane with the optical axis of the telescope) can be shown to be non-liner in nature. To account for it
requires the introduction of quadratic terms and additional plate constants, and greatly complicates the solution.
This is usually a small effect; the small size of CCD fields combined with the overall accuracy of the GSC and
USNO-SA10.0 catalogs make it even less significant. Along with Montenbruck and Pfleger, we have chosen
not to include it.
VI-4. Ephemeris Generation
Ephemeris generation (Astrometry Toolkit only) involves using orbital elements to determine the instantaneous position
of the asteroid or comet, and then converting that position to the desired coordinate system. (In general, it also includes
first calculating osculating orbital elements at an epoch near the time of the desired ephemeris. This is a complicated
process involving numerical integration and accurate positions of the planets. Since up-to-date osculating elements of the
asteroids are always available for download (see Section V-2.3), we use them as our starting point.) We give here a basic
outline of the process of ephemeris generation. The specific formulae, algorithms, and procedures employed in the
software are taken primarily from Danby, Meeus, and Bretagnon and Simon. They should be consulted if additional
information is required. (Green is also a good source of information on many of these topics.)
For each point in the desired ephemeris:
1.

Using the mean motion and the perigee time, compute the mean anomaly at the desired time. (The mean
motion is the reciprocal of the period, which is computed from the semi-major axis (a) and the sun’s mass. The
mean anomaly is the angular position of the body assuming uniform motion in a fictitious circular orbit.)

2.

Solve Kepler’s equation to obtain the true anomaly from the mean anomaly. This is generally done on computers using Newton’s method or a modification. We use the accelerated convergence method from Danby,
Section 6.6.

3.

From the orbital elements and the true anomaly, compute the heliocentric position of the body.

4.

Compute the position of the Sun at the time in question and use it to compute the geocentric position of the
body.

5.

Precess the result to the desired epoch.

The resulting ephemeris positions are Astrometric Coordinates. This means that they are precessed to a standard
epoch, and light-time corrections have been applied. Nutation, and aberration corrections are not applied. These
coordinates are suitable for comparison with catalogs and star charts.
VI-5. Additional Information and Software
VI-5.1. Reporting to the Minor Planet Center
Observers who wish to report astrometric results to the minor planet center should begin by visiting their website (http://
cfa-www.harvard.edu/cfa/ps/mpc.html) and taking careful note of the material available there. In particular, the
documents entitled Guide to Minor-Body Astrometry and Format for Optical Astrometric Observations of Comets and
Minor Planets should be downloaded and studied.
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While we have made every effort to insure that reports generated by the Astrometry Toolkit are properly formatted, we
have also supplied an editing facility, and the ultimate responsibility rests with the user. Observers are particularly urged
to study the instructions on observer-assigned temporary designations of unknown asteroids, the assignment and format of
official temporary and permanent designations, and the assignment of observatory codes, as well as the remarks on the
expected quality of submitted measurements and how to obtain accurate times.
VI-5.2. Orbit Determination
Observers interested in actually computing an orbit from observed positions should be aware that an excellent program
for this purpose, FIND_ORB, is available as copyrighted freeware, along with documentation. See the website at http://
www.projectpluto.com.

References
Bretagnon, P., and Simon, J.-L., Planetary Programs and Tables from -4000 to +2800, Willmann-Bell Inc., Richmond,
1986
Danby, J.M.A., Fundamentals of Celestial Mechanics, 2nd Ed., Willman-Bell Inc., Richmond, 1988
Green, R.M., Spherical Astronomy, Cambridge University Press, Cambridge, 1985
Meeus, J., Astronomical Algorithms, Willman-Bell Inc., Richmond, 1991
Montenbruck, O., and Pfleger, T., Astronomy on the Personal Computer, 2nd Ed., trans. S. Dunlop, Springer-Verlag, Berlin,
1994

PAGE 17

